
6 Uncheck Wait for dial tone before dialing. Tap Finish.

7 Now you are ready to start the connection. In the Connections screen, under Internet Settings, tap Connect. In Network Log 
On, verify the dialing settings. Tap OK.

8 ONLY FOR MOTOROLA TIMEPORT 270C OR NOKIA 3650/6310/7650/8910/8910i: 

a) After you tap Connect for the first time, the phone will display a message asking if you want to bond. On Motorola, enter 
GRANT; on Nokia, enter ACCEPT. 

b) Make up a 4-16 digit passkey, enter it on the phone, then enter it on the Dolphin 9500/9550.

Note: The Bluetooth icon on the Today screen will blink to indicate a connection.

c) After successfully bonding, you can set up the phone to automatically connect to your Dolphin 9500/9550 without requiring a 
passkey.

Automatic Connections for Motorola Timeport 270C:

• On the phone, press MENU.
• Scroll to Settings, then press SELECT.
• Scroll to Connection, then press ON.
• On Bluetooth Link, press SELECT.
• Scroll to Devices, then press SELECT.
• Choose your mobile computer, then press EDIT.
• Scroll to Access:Ask, then press CHANGE.
• Scroll to Automatic, then press SELECT. Press DONE.
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Automatic Connections for Nokia 3650/7650:

• On the phone, press MENU.
• Scroll to Connectivity, then press Options.
• The Open option should be highlighted. Press Select.
• The Bluetooth option should be highlighted. Press Options.
• The Open option should be highlighted. Press Select.
• Scroll to the right tab to access the Paired devices list. Highlight your mobile computer, then press Options.
• Scroll to Set as authorized, then press Select.
• In the confirmation screen, press Yes.

Automatic Connections for Nokia 6310/8910/8910i:

• On the phone, press MENU.
• Scroll to 10 Bluetooth, then press SELECT.
• Scroll to 4 View Paired Devices, then press SELECT.
• Highlight the Dolphin 9500/9550, then press OPTIONS.
• Scroll to 3 Request Connection Authorization, then press NO.

To use a different Bluetooth phone for dial-up networking, you can use the same connection setup, but you must make the new 
phone your favorite. Just run the Get Connected! Wizard again, select the new phone, and make it your new Favorite when 
prompted. 

Alternatively, you can use the Bluetooth Devices folder to change your favorite phone. Refer to Using the Dolphin 9500/9550 
Mobile Computer beginning on page 4-1 for instructions.
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Customizing Your Dolphin 9500/9550
You can customize your Dolphin 9500/9550 by 

• adjusting device settings and 
• installing additional software.

Adjusting Device Settings

You can adjust device settings to suit the way you work. To see available options, tap Start > Settings > Personal or System 
tab located at the bottom of the screen.

You might want to adjust the following:

Clock to change the time or to set alarms

Menus to customize what appears on the Start menu, and to enable a pop-up menu from the New button

Owner Information to enter your contact information

Password to limit access to your device

Power to maximize battery life

Today to customize the look and the information that is displayed on the Today screen
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Installing additional software

There are programs autoinstalled on your device when it is first booted up. For more information, see Autoinstall on page 2-10.

You can install any program created for your device, as long as your device has enough memory to store it and the program has 
an  *.exe, *.cab, or *.dll extension. The most popular place to find software for your device is on the Pocket PC Web site (http://
www.microsoft.com/mobile/pocketpc). 

To add programs using ActiveSync (v3.7 or higher)
You install the appropriate software for your device on your desktop computer before installing it on your device.

1 Determine your device and processor type so that you know which version of the software to install. Tap Start > Settings > 
System tab > About. The Version tab appears displaying the current information.

2 On the Version tab, make a note of the information in the Processor section. 

3 Download the program to your desktop computer (or insert the CD or disk that contains the program into your desktop 
computer). You may see a single *.exe or setup.exe file, a *.cab file, or *.dll. There may also be several versions of files for 
different device types and processors. 
Be sure to select the program designed for the Pocket PC and your device processor type.

4 Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide 
special installation instructions.

5 Connect your device and desktop computer.

6 Double-click the *.exe file.

If the file is an installer, the installation wizard will begin. Follow the directions on the screen. Once the software has been installed 
on your desktop computer, the installer will automatically transfer the software to your device. 

If the file is not an installer, you will see an error message stating that the program is valid but it is designed for a different type 
of computer. You will need to move this file to your device. If you cannot find any installation instructions for the program in the 
Read Me file or documentation, use ActiveSync Explore to copy the program file to the Program Files folder on your device. For 
more information on copying files using ActiveSync, see ActiveSync Help. 

Once installation is complete, tap Start > Programs, and then the program icon to switch to it.

To add a program directly from the Internet
Your device must have an internet connection.

1 Determine your device and processor type so that you know which version of the software to install. Tap Start and then 
Settings. On the System tab, tap About. In the Version tab, make a note of the information in Processor. 

2 Download the program to your device straight from the Internet using Pocket Internet Explorer. You may see a single *.exe or 
Setup.exe file, or several versions of files for different device types and processors. 
Be sure to select the program designed for the Pocket PC and your device processor type.

3 Read any installation instructions, Read Me files, or documentation that comes with the program. Many programs provide 
special installation instructions.

4 Tap the file, such as an *.exe file. The installation wizard will begin. Follow the directions on the screen.

Adding a Program to the Start Menu
Tap Start >  Settings > Menus >  Start Menu tab. Tap the check box for the program you want to add. 

If you do not see the program listed, you can either use File Explorer on the device to move the program to the Start Menu folder, 
or use ActiveSync on the desktop computer to create a shortcut to the program and place the shortcut in the Start Menu folder.

Note: We recommend that you copy and paste special so that you do not alter your program configurations by accident.

1 Tap Start > Programs > File Explorer, and locate the program (tap the folder list, labeled My Documents by default, and 
then My Device to see a list of all folders on the device). 

2 Tap and hold the program and tap Cut on the pop-up menu. 
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3 Open the Start Menu folder located in the Windows folder, tap and hold a blank area of the window, and tap Paste on the 
pop-up menu. 

4 The program should now appear on the Start menu.

Using ActiveSync on the desktop computer: Use the Explorer in ActiveSync to explore your device files and locate the 
program. Right-click the program, and then click Create Shortcut. Move the shortcut to the Start Menu folder in the Windows 
folder. The shortcut now appears on the Start menu. For more information, see ActiveSync Help.

Removing Programs
Tap Start > Settings > System tab > Remove Programs.

If the program does not appear in the list of installed programs, use File Explorer on your device to locate the program, tap and 
hold the program, and then tap Delete on the pop-up menu.
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Applications
Microsoft Pocket Outlook includes Calendar, Contacts, Tasks, Inbox, and Notes. You can use these programs individually or 
together. For example, e-mail addresses stored in Contacts can be used to address e-mail messages in Inbox. 

Using Microsoft ActiveSync, you can synchronize information in Microsoft Outlook or Microsoft Exchange on your desktop 
computer with your device. You can also synchronize this information directly with a Microsoft Exchange server. Each time you 
synchronize, ActiveSync compares the changes you made on your device and desktop computer or server and updates both 
computers with the latest information. For information on using ActiveSync, see ActiveSync Help on the desktop computer.

You can switch to any of these programs by tapping them on the Start menu.
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Calendar: Scheduling Appointments and Meetings

Use Calendar to schedule appointments, including meetings and other events. You can check your appointments in one of 
several views (Agenda, Day, Week, Month, and Year) and easily switch views by using the View menu.

Note: You can customize the Calendar display, such as changing the first day of the week, by tapping Options on the Tools 
menu. 

To create an appointment:

1 If you are in Day or Week view, tap the desired date and time for the appointment.

2 Tap New.

Tap to go to today.

Tap to display or edit
the appointment details.

Tap to create a new appointment.

Calendar Application
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3 Using the input panel, enter a description and a location. Tap first to select the field. 

4 If needed, tap the date and time to change them.

5 Enter other desired information. You will need to hide the input panel to see all available fields.

6 To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating notes, 
refer to Notes on page 7-11.

7 When finished, tap OK to return to the calendar. 

Note: If you select Remind me in an appointment, your device will remind you according to the options set in Start, Settings, 
Personal tab, Sounds & Reminders. 

Using the Summary Screen
When you tap an appointment in Calendar, a summary screen is displayed. To change the appointment, tap Edit.

Tap to select a date.

Tap to select a time.

Tap to return to the calendar
(the appointment is saved
automatically).

Tap to choose from
previously entered locations.

Tap to choose from
predefined text.

Notes is a good place
for maps and directions.

Entering an Appointment
Dolphin® 9500/9550 Mobile Computer User’s Guide 7 - 3



Creating Meeting Requests
You can use Calendar to set up meetings with users of Outlook or Pocket Outlook. The meeting request will be created 
automatically and sent either when you synchronize Inbox or when you connect to your e-mail server. Indicate how you want 
meeting requests sent by tapping Tools and then Options. If you send and receive e-mail messages through ActiveSync, select 
ActiveSync.

To schedule a meeting:

1 Create an appointment.

2 In the appointment details, hide the input panel, and then tap Attendees.

3 From the list of e-mail addresses you’ve entered in Contacts, select the meeting attendees. 

The meeting notice is created automatically and placed in the Outbox folder.

For more information on sending and receiving meeting requests, see Calendar Help and Inbox Help on the device.

View appointment details.

View.

Tap to change
appointment.

Appointment Summary Screen
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Contacts

Contacts maintains a list of your friends and colleagues so that you can easily find the information you’re looking for, whether 
you’re at home or on the road. Using the device infrared (IR) port, you can quickly share Contacts information with other device 
users.

Note: To change the way information is displayed in the list, tap Tools and then Options.

Tap and enter part of a name to
quickly find it in the list.

Tap to display or edit
the contact details.

Tap and hold to display
a pop-up menu of actions.

Tap to see additional phone
numbers and e-mail addresses.

Tap to create a new contact.

Select the category of contacts
you want displayed in the list.

Contact Application
Dolphin® 9500/9550 Mobile Computer User’s Guide 7 - 5



To create a contact:

1 Tap New.

2 Using the input panel, enter a name and other contact information. You will need to scroll down to see all available fields.

3 To assign the contact to a category, scroll to and tap Categories and select a category from the list. In the contact list, you 
can display contacts by category.

4 To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating notes, 
refer to Notes on page 7-11.

5 When finished, tap OK to return to the contact list.

There are four ways to find a contact: 

• In the contact list, enter a contact name in the box under the navigation bar. To show all contacts again, clear text from the 
box or tap the button to the right of the box. 

• In the contact list, tap the category list (labeled All Contacts by default) and select the type of contact that you want displayed. 
To show all contacts again, select All Contacts. To view a contact not assigned to a category, select None. 

• To view the names of companies your contacts work for, in the contact list, tap View > By Company. The number of contacts 
that work for that company will be displayed to the right of the company name. 

• Tap , Find, enter the contact name, select Contacts for the type, and then tap Go. 

Using the Summary Screen
When you tap a contact in the contact list, a summary screen is displayed. To change the contact information, tap Edit.

Notes is a good place
for maps and directions.

Tap to return to the contact
list (the contact is saved
automatically).

Scroll to see more fields.

Creating a Contact
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View contact details.

Tap to view notes.

Tap to change contact information.

Contacts Summary Screen
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Tasks

Use Tasks to keep track of what you have to do. 

Note: To change the way information is displayed in the list, tap Tools and then Options.

Tap to create a new  task.

Select the sort order
of the list.

Indicates high priority.

Select the category of tasks
you want displayed in the list.

Tap to display or edit
the task details.

Tap and hold to display
a pop-up menu of actions.

Task Application
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To create a task:

1 Tap New.

2 Using the input panel, enter a description.

3 You can enter a start date and due date or enter other information by first tapping the field. If the input panel is open, you will 
need to hide it to see all available fields.

4 To assign the task to a category, tap Categories and select a category from the list. In the task list, you can display tasks by 
category.

5 To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more information on creating notes, 
refer to Notes on page 7-11.

6 When finished, tap OK to return to the task list.

Note: To quickly create a task with only a subject, tap Entry Bar on the Tools menu. Then, tap Tap here to add a new task 
and enter your task information.

Tap to return to the task
list (the task is saved
automatically).

Tap to choose from
predefined subjects.

Notes is a good place
for maps and drawings.

Creating a Task
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Using the Summary Screen
When you tap a task in the task list, a summary screen is displayed. To change the task, tap Edit.

View task details.

View notes.

Tap to show and hide additional
summary information.

Tap to change task.

Task Summary Screen
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Notes

Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with Notes. You can create a written note or a 
recording. You can also include a recording in a note. If a note is open when you create the recording, it will be included in the 
note as an icon. If the note list is displayed, it will be created as a stand-alone recording.

To create a note:

1 Tap New.

2 Create your note by writing, drawing, typing, and recording. For more information about using the input panel, writing and 
drawing on the screen, and creating recordings, see Using the Dolphin 9500/9550 Mobile Computer on page 4-1.

Tap to open a note or
play a recording.

Tap and hold to display
a pop-up menu of actions.

Tap to create a new  item.

Tap to change the sort
order of the list.

Tap to show or hide the
Recording toolbar.

Tap to record.

Notes Application
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Tap to return to the note
list (the note is saved
automatically).

Tap to write on the screen.

Tap to show or hide
the input panel.

Tap to add a recording
to the note.

Creating a Note
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Inbox

Use Inbox to send and receive e-mail messages in either of these ways: 

• Synchronize e-mail messages with Microsoft Exchange or Microsoft Outlook on your desktop computer.
• Send and receive e-mail messages by connecting directly to an e-mail server through an Internet service provider (ISP) or a 

network.

Synchronizing E-mail Messages
E-mail messages can be synchronized as part of the general synchronization process. You will need to enable Inbox 
synchronization in ActiveSync. For information on enabling Inbox synchronization, see ActiveSync Help on the desktop 
computer.

During synchronization:

• Messages are copied from the mail folders of Exchange or Outlook on your desktop computer to the ActiveSync folder in Inbox 
on your device. By default, you will receive messages from the past three days only, the first 100 lines of each message, and 
file attachments of less than 100 KB in size.

• E-mail messages in the Outbox folder on your device are transferred to Exchange or Outlook, and then sent from those 
programs.

• E-mail messages in subfolders must be selected in ActiveSync on your desktop computer in order to be transferred.

Note: You can also synchronize e-mail messages with your desktop computer from a remote location. For more information, 
see Chapter 7.

Connecting Directly to an E-mail Server
In addition to synchronizing e-mail messages with your desktop computer, you can send and receive e-mail messages by 
connecting to an e-mail server.

When you connect to the e-mail server, new messages are downloaded to the device Inbox folder, messages in the device 
Outbox folder are sent, and messages that have been deleted on the e-mail server are removed from the device Inbox folder.

Messages that you receive directly from an e-mail server are linked to your e-mail server rather than your desktop computer. 
When you delete a message on your device, it is also deleted from the e-mail server the next time you connect based on the 
settings you selected in ActiveSync.

You can work online or offline. When working online, you read and respond to messages while connected to the e-mail server. 
Messages are sent as soon as you tap Send, which saves space on your device.

When working offline, once you’ve downloaded new message headers or partial messages, you can disconnect from the e-mail 
server and then decide which messages to download completely. The next time you connect, Inbox downloads the complete 
messages you’ve marked for retrieval and sends the messages you’ve composed.
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Using the Message List
Messages you receive are displayed in the message list. By default, the most recently received messages are displayed first in 
the list.

When you receive a message, tap it to open it. Unread messages are displayed in bold.

Select the sort order
for messages.

Select the service and folder
you want to display.

Tap to connect to
the selected service.

Tap to connect and to
send and receive e-mail.

Tap to open a message.

Tap and hold to display
a pop-up menu of actions.

InBox Application
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When you connect to your e-mail server or synchronize with your desktop computer, by default, you’ll receive messages from 
the last five days only, the first 100 lines of each new message, and file attachments of less than 100 KB in size. The original 
messages remain on the e-mail server or your desktop computer. 

You can mark the messages that you want to retrieve in full during your next synchronization or e-mail server connection. In the 
message list, tap and hold the message you want to retrieve. On the pop-up menu, tap Mark for Download. The icons in the 
Inbox message list give you visual indications of message status.

You specify your downloading preferences when you set up the service or select your synchronization options. You can change 
them at any time:

• Change options for Inbox synchronization using ActiveSync options. For more information, see ActiveSync Help.
• Change options for direct e-mail server connections in Inbox on your device. Tap Tools and then tap Options. On the Service 

tab, tap the service you want to change. Tap and hold the service and select Delete to remove a service.

Tap to delete this message.

Tap to view  the previous
or next message.

Tap to reply to or
forward this message.

Tap to return to
the message list.

Viewing A Message
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Composing Messages

To compose a message:

1 Tap New. 

2 In the To field, enter an e-mail or SMS address of one or more recipients, separating them with a semicolon, or select a name 
from the contact list by tapping the Address Book button. 
All e-mail addresses entered in the e-mail fields in Contacts appear in the Address Book.

• Compose your message. To enter preset or frequently used messages, tap My Text and select a message.
• Tap Send when you’ve finished the message. If you are working offline, the message is moved to the Outbox folder and will 

be sent the next time you connect.

If you are sending an SMS message and want to know if it was received, tap Edit, Options, and select Request SMS text 
message delivery notification before sending the message.

Tap to show or hide
the complete header.

Tap to send the message.

Tap to insert common messages.

Tap to show / hide the
recording toolbar.

Tap to display the Address Book.

Creating a Message
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Managing E-mail Messages and Folders
By default, messages are displayed in one of five folders for each service you have created: Inbox, Deleted Items, Drafts, Outbox, 
and Sent Items. The Deleted Items folder contains messages that have been deleted on the device. The behavior of the Deleted 
and Sent Items folders depends on the options you have chosen. In the message list, tap Tools and then Options. On the 
Message tab, select your options.

If you want to organize messages into additional folders, tap Tools, and then Manage Folders to create new folders. To move 
a message to another folder, in the message list, tap and hold the message and then tap Move to on the pop-up menu.

Folder behavior with a direct connection to an e-mail server

The behavior of the folders you create depends on whether you are using ActiveSync, SMS, POP3, or IMAP4. 

• If you use ActiveSync, e-mail messages in the Inbox folder in Outlook will automatically be synchronized with your device. 
You can select to synchronize additional folders by designating them for ActiveSync. The folders you create and the 
messages you move will then be mirrored on the server. For example, if you move two messages from the Inbox folder to a 
folder named Family, and you have designated Family for synchronization, the server creates a copy of the Family folder and 
copies the messages into that folder. You can then read the messages while away from your desktop computer.

• If you use SMS, messages are stored in the Inbox folder. 
• If you use POP3 and you move e-mail messages to a folder you created, the link is broken between the messages on the 

device and their copies on the mail server. The next time you connect, the mail server will see that the messages are missing 
from the device Inbox and delete them from the server. This prevents you from having duplicate copies of a message, but it 
also means that you will no longer have access to messages that you move to folders created from anywhere except the 
device. 

• If you use IMAP4, the folders you create and the e-mail messages you move are mirrored on the server. Therefore, messages 
are available to you anytime you connect to your mail server, whether it is from your device or desktop computer. This 
synchronization of folders occurs whenever you connect to your mail server, create new folders, or rename/delete folders 
when connected. 
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Synchronizing Your Dolphin 9500/9550 Terminal
Overview

Using Microsoft ActiveSync version 3.7 or higher, you can synchronize information on your desktop computer with your 
device and vice versa. Synchronization compares the data on your Dolphin mobile computer with your desktop computer and 
updates both with the most recent data. 

For example, you can:

• Update the information in Pocket Outlook on your device by synchronizing it with Microsoft Outlook on your desktop computer. 
• Synchronize Microsoft Word and Microsoft Excel files between your device and desktop computer. Your files are automatically 

converted to the correct format.

Capabilities
With ActiveSync, you can also:

• Back up and restore your device data. 
• Copy (rather than synchronize) files between your device and desktop computer.
• Control when synchronization occurs by selecting a synchronization mode. For example, you can synchronize continually 

while connected to your desktop computer or only when you choose the synchronize command.
• Select which information types are synchronized and control how much data is synchronized. For example, you can choose 

how many weeks of past appointments you want synchronized.\

Note: By default, ActiveSync does not automatically synchronize all types of information. Use ActiveSync Options to specify the 
types of information you want to synchronize. The synchronization process makes the data (in the information types you 
select) identical on both your desktop computer and your device.

Requirements
To synchronize, ActiveSync version 3.7 or higher must be on both your desktop computer and your device. ActiveSync 3.7 is 
already installed on your device. Therefore, you must install ActiveSync 3.7 on your desktop computer from the Pocket PC 
Companion CD.    

To install ActiveSync on your desktop computer, insert the Pocket PC Companion CD into the CD-ROM drive of your desktop 
computer. Click the yellow arrow, click Start Here, then follow the directions on your screen.
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Setting up your desktop computer

When installation of ActiveSync is complete on your desktop computer, the ActiveSync Setup Wizard helps you 

• connect your device to your desktop computer, 
• set up a partnership so you can synchronize information between your device and your desktop computer, and 
• customize your synchronization settings. 

Synchronizing from your desktop computer
Because ActiveSync is already installed on your device, your first synchronization process begins automatically when you finish 
setting up your desktop computer in the wizard. 

After your first synchronization, look at Calendar, Contacts, and Tasks on your device. Notice that the same information from 
Microsoft Outlook on your desktop computer is now on your device, and you didn’t have to type a word. Simply disconnect your 
device from your computer and you’re ready to go!

For more information about using ActiveSync on your desktop computer, open ActiveSync, then open ActiveSync Help.

Synchronizing from your device
You must have setup ActiveSync on your desktop computer and completed the first synchronization process before you initiate 
synchronization from your device.

To initiate synchronization from your device, tap Start, then ActiveSync to begin the process. 

Note: If you have a wireless LAN card, you can synchronize remotely from your device.

For more information about ActiveSync on your device, switch to ActiveSync, tap Start, then Help.

Tap to connect and synchronize.

View synchronization status.

Tap to synchronize via IR or
change synchronization settings.

View connection status.

Tap to stop synchronization.
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Getting Connected
You can exchange information between your Dolphin 9500/9550 and other mobile devices, a desktop computer, a network, or 
the Internet. You have the following connection options:

• Use the infrared (IR) port on your device to send and receive files between two devices.
• Connect to your Internet service provider (ISP). Once connected, you can send and receive e-mail messages by using Inbox 

and view Web or WAP pages by using Microsoft Pocket Internet Explorer. The communication software for creating an ISP 
connection is already installed on your device. Your service provider will provide software needed to install other services, 
such as paging and fax services.

• Connect to your desktop computer to synchronize remotely. Once connected, you can synchronize information such as your 
Pocket Outlook information. 

Get Help on Connecting
More information on the procedures described here, as well as information on additional procedures, can be found in the following 
locations:

• “Inbox: Sending and Receiving E-mail Messages” in Chapter 4.
• Online Help on the device. Tap Start and then Help. Tap View, All Installed Help, and then Inbox or Connections.
• ActiveSync Help on the desktop computer. In ActiveSync, click Microsoft ActiveSync Help on the Help menu.

For troubleshooting information, go to the Pocket PC Web site at: http://www.microsoft.com/windowsmobile/products/pocketpc/
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Transfer Items Using Infrared

Using infrared (IR), you can send and receive information, such as contacts and appointments, between two Windows-equipped 
devices.

Verify Beam Settings 

For IR receive to work automatically, the Beam Settings must be correct. 

To verify, tap Start > Settings > Connections tab > Beam. The following window should appear.   

If this box is not checked, select Start>Programs>Infrared Receive before receiving data from another device. The terminal 
searches for another device.

To send information

Assuming your Beam Settings are correct:

1 Open the program where you created the item you want to send and locate the item in the list.
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2 Align the IR ports so that they are unobstructed and within a close range.

3 Tap and hold the item, then tap Beam Item on the pop-up menu.

Note: You can also send items, but not folders, from File Explorer. Tap and hold the item you want to send, and then tap Beam 
File on the pop-up menu.

To receive information:

1 Align the IR ports so that they are unobstructed and within a close range.

2 Have the owner of the other device send the information to you. Your device will automatically receive it.
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Pocket Internet Explorer 
Overview

Use Microsoft Pocket Internet Explorer to view Web or WAP pages in either of these ways:

• During synchronization with your desktop computer, download your favorite links and mobile favorites that are stored in the 
Mobile Favorites subfolder in Internet Explorer on the desktop computer.

• Connect to an Internet service provider (ISP) or network and browse the Web. 

When connected to an ISP or network, you can also download files and programs from the Internet or intranet.

Accessing Pocket Internet Explorer
To switch to Pocket Internet Explorer, tap Start and then Internet Explorer.

You can use Pocket Internet Explorer to browse Mobile Favorites and channels that have been downloaded to your device 
without connecting to the Internet. You can also connect to the Internet through an ISP or a network connection and browse the 
Web.

To browse the Internet on your terminal

1 Set up a connection to your ISP or corporate network using Connections; see Getting Connected on page 9-1.

Note: If you select Pocket Internet Explorer before setting up the network connections, a screen may appear allowing you to 
proceed to the connection settings screen. After you select the settings, you return to Pocket Internet Explorer. To add a 
favorite link while using the device, go to the page you want to add, tap and hold on the page, and tap Add to Favorites.

2 To connect and start browsing, tap View and then Address Bar. 

3 In the address bar that appears at the top of the screen, enter the Web address you want to visit and then tap Go. 

4 Tap the arrow to choose from previously entered addresses.

If Mobile Favorites have been set up, you can click one of them to start browsing. See The Mobile Favorites Folder on page 10-2.
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The Mobile Favorites Folder

Purpose

The Mobile Favorites folder was created on your desktop computer when you installed ActiveSync. It enables you to create 
Favorite Links on your desktop computer that you can transfer to your Dolphin 9500/9550 terminal. Those Favorite Links are then 
available for selection when browsing the internet on your terminal. 

Process

First, you create your Favorite Links in the Mobile Favorites folder on your desktop computer. Then, the next time you sync your 
desktop computer with your terminal, those Mobile Favorites are transferred to the Mobile Favorites folder on to your terminal. 

Only items stored in the Mobile Favorites subfolder in the Favorites folder in Internet Explorer on your desktop computer are 
synchronized with the Mobile Favorites folder on your terminal. 

Note: Unless you mark a Favorite Link as a mobile favorite, only the link downloads to your terminal and you will need to connect 
to your ISP or network to view the content. For more information on synchronization, see ActiveSync Help on the desktop 
computer.

Creating and Synchronizing Mobile Favorites 
If you are using Microsoft Internet Explorer 5.0 or later on your desktop computer, you can download Mobile Favorites to your 
device. Synchronizing mobile favorites downloads Web content to your device so that you can view pages while you are 
disconnected from your ISP and desktop computer.

Use the Internet Explorer plug-in installed with ActiveSync to create mobile favorites

Complete these steps:

1 On your desktop computer, open Internet Explorer, click Tools and then Create Mobile Favorite.

2 To change the link name, enter a new name in the Name box. 

3 Optionally, in Update, select a desired update schedule.

4 Click OK. Internet Explorer downloads the latest version of the page to your desktop computer.

5 If you want to download the pages that are linked to the mobile favorite you just created, in Internet Explorer on the desktop 
computer, right-click the mobile favorite and then click Properties. In the Download tab, specify the number of links deep 
you want to download. To conserve device memory, go only one level deep.

6 Synchronize your device and desktop computer. Mobile favorites that are stored in the Mobile Favorites folder in Internet 
Explorer are downloaded to your device.

If you did not specify an update schedule in Step 3, you will need to manually download content to keep the information updated 
on your desktop computer and device. Before synchronizing with your device, in Internet Explorer on your desktop computer, 
click Tools and then Synchronize. You will see the last time content was downloaded to the desktop computer, and you can 
manually download content if needed.

You can add a button to the Internet Explorer toolbar for creating mobile favorites. In Internet Explorer on your desktop computer, 
click View, Toolbars, and then Customize.

To view mobile favorites and channels on the terminal

1 Access Pocket Internet Explorer.

2 Tap the Favorites button to display your list of favorites . 
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3 Tap the page you want to view. 

You’ll see the page that was downloaded the last time you synchronized with your desktop computer. If the page is not on your 
device, the favorite will be dimmed. You will need to synchronize with your desktop computer again to download the page to your 
device, or connect to the Internet to view the page.

Saving memory on your terminal

Mobile favorites take up storage memory on your device. 

To minimize the amount of memory used:

• In the settings for the Favorites information type in ActiveSync options, turn off pictures and sounds, or stop some 
mobile favorites from being downloaded to the device. For more information, see ActiveSync Help.

• Limit the number of downloaded linked pages. In Internet Explorer on the desktop computer, right-click the mobile 
favorite you want to change and then Properties. On the Download tab, specify 0 or 1 for the number of linked pages 
you want to download.

Tap to add or delete
a folder or favorite link.

Tap the favorite you
want to view.
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Using AvantGo Channels

AvantGo is a free interactive service that gives you access to personalized content and thousands of popular Web sites. You 
subscribe to AvantGo channels directly from your device. Then, you synchronize your device and desktop computer, or connect 
to the Internet to download the content. For more information, visit the AvantGo Web site.

To sign up for AvantGo: 

1 In ActiveSync options on the desktop computer, turn on synchronization for the AvantGo information type.

2 In Pocket Internet Explorer on your device, tap the Favorites button to display your list of favorites .

3 Tap the AvantGo Channels link.

4 Tap the Activate button.

5 Follow the directions on the screen. You will need to synchronize your device with your desktop computer and then tap the 
My Channels button to complete the AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your list of favorites to see a few of the most popular 
channels. To add or remove channels, tap the Add or Remove link.
10 - 4 Dolphin® 9500/9550 Mobile Computer User’s Guide



11
D

Companion Programs
Available companion programs

The companion programs for Pocket PC are

• Microsoft Pocket Word and 
• Microsoft Pocket Excel. 

Media Player, Microsoft ® Money, MSN Messenger, Microsoft Reader are NOT included on the Dolphin 9500/9550 but maybe 
installed from the Microsoft Companion CD.

Accessing companion programs

To switch to a companion program on your device, tap Start > Programs > then tap the program name.

Pocket Word

Pocket Word works with Microsoft Word on your desktop computer to give you easy access to copies of your documents. You 
can create new documents on your device, or you can copy documents from your desktop computer to your device. Synchronize 
documents between your desktop computer and your device so that you have the most up-to-date content in both locations.

Use Pocket Word to create documents, such as letters, meeting minutes, and trip reports. To create a new file, tap Start> 
Programs>Pocket Word>New. A blank document appears. Or, if you’ve selected a template for new documents in the Options 
dialog box, that template appears with appropriate text and formatting already provided. You can open only one document at a 
time; when you open a second document, you’ll be asked to save the first. You can save a document you create or edit in a 
variety of formats, including Word (.doc), Pocket Word (.psw), Rich Text Format (.rtf), and Plain Text (.txt). 

Using Pocket Word   
Pocket Word contains a list of the files stored on your device. Tap a file in the list to open it. To delete, make copies of, and send 
files, tap and hold a file in the list. Then, select the appropriate action on the pop-up menu.

Tap to change the sort
order of the list.

Tap to open a document.

Tap and hold an item to see
a pop-up menu of actions.

Tap to create a new document.

Select the type of folder you
want displayed in the list.
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You can enter information in Pocket Word in one of four modes (typing, writing, drawing, and recording), which are displayed on 
the View menu. Each mode has its own toolbar, which you can show and hide by tapping the Show/Hide Toolbar button on the 
command bar.

You can change the zoom magnification by tapping View and then Zoom. Then select the percentage you want. Select a higher 
percentage to enter text and a lower one to see more of your document.

If you’re opening a Word document created on a desktop computer, select Wrap to Window on the View menu so that you can 
see the entire document.

Typing Mode
Using the input panel or Dolphin keypad, enter typed text into the document. For more information on entering typed text, see 
Using the Dolphin 9500/9550 Mobile Computer on page 4-1.

To format existing text and to edit text, first select the text. You can select text as you do in a Word document, using your stylus 
instead of the mouse to drag through the text you want to select. You can search a document to find text by tapping Edit and then 
Find/Replace.

Tap to change
formatting options.

Tap to format text.

Tap and hold to see a
pop-up menu of actions.

Tap to show or hide
the toolbar.

Tap to return to the
document list (changes are
saved automatically).
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Writing Mode
In writing mode, use your stylus to write directly on the screen. Ruled lines are displayed as a guide, and the zoom magnification 
is greater than in typing mode to allow you to write more easily. 

For more information on writing and selecting writing, see Using the Dolphin 9500/9550 Mobile Computer on page 4-1. 

Writing on the Screen in Pocket Word     

If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, and can be edited and manipulated as 
described in the following section.

Written words are converted to graphics (metafiles) when a Pocket Word document is converted to a Word document on your 
desktop computer.

With Space button selected,
drag to insert space. An arrow
appears showing the space
direction and size.

Tap to highlight selected text.

Space button.

Tap to select formatting options,
such as pen weight and line color.

Pen button.
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Drawing Mode

In drawing mode, use your stylus to draw on the screen. Gridlines appear as a guide. When you lift your stylus off the screen 
after the first stroke, you’ll see a drawing box indicating the boundaries of the drawing. Every subsequent stroke within or touching 
the drawing box becomes part of the drawing. 

For more information on drawing and selecting drawings, see Using the Dolphin 9500/9550 Mobile Computer on page 4-1.

For more information on using Pocket Word, tap Start and then Help.

Select Shape on the
pop-up menu to convert
objects to proper shapes.

Resize an object by dragging
the selection handles.

Tap an arrow  to
see your choices.

Tap to select formatting options,
such as line weight, fill color, and line color.

Pen button.
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Pocket Excel

Pocket Excel works with Microsoft Excel on your desktop computer to give you easy access to copies of your workbooks. You 
can create new workbooks on your device, or you can copy workbooks from your desktop computer to your device. Synchronize 
workbooks between your desktop computer and your device so that you have the most up-to-date content in both locations.

Use Pocket Excel to create workbooks, such as expense reports and mileage logs. To create a new file, tap Start, Programs, 
Pocket Excel, and then New. A blank workbook appears. Or, if you’ve selected a template for new workbooks in the Options 
dialog box, that template appears with appropriate text and formatting already provided. You can open only one workbook at a 
time; when you open a second workbook, you’ll be asked to save the first. You can save a workbook you create or edit in a variety 
of formats, including Pocket Excel (.pxl) and Excel (.xls).

Pocket Excel contains a list of the files stored on your device. Tap a file in the list to open it. To delete, make copies of, and send 
files, tap and hold a file in the list. Then select the appropriate action from the pop-up menu.

Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, sorting, and filtering. To display the toolbar, 
tap View and then Toolbar. 

If your workbook contains sensitive information, you can protect it with a password. To do so, open the workbook, tap Edit, and 
then Password. Every time you open the workbook, you will need to enter the password, so choose one that is easy for you to 
remember but hard for others to guess.

Tips for Working in Pocket Excel

When working in large worksheets in Pocket Excel:

• View in full-screen mode to see as much of your worksheet as possible. Tap View and then Full Screen. To exit full-screen 
mode, tap Restore.

• Show and hide window elements. Tap View and then tap the elements you want to show or hide.
• Freeze panes on a worksheet. First select the cell where you want to freeze panes. Tap View and then Freeze Panes. You 

might want to freeze the top and left-most panes in a worksheet to keep row and column labels visible as you scroll through 
a sheet.

• Split panes to view different areas of a large worksheet. Tap View and then Split. Then drag the split bar to where you want 
it. To remove the split, tap View and then Remove Split.

• Show and hide rows and columns. To hide a hidden row or column, select a cell in the row or column you want to hide. Then 
tap Format, then Row or Column, and then Hide. To show a hidden row or column, tap Tools, then Go To, and then type a 
reference that is in the hidden row or column. Then tap Format, then Row or Column, and then Unhide.

For more information on using Pocket Excel, tap Start and then Help.

Cell contents appear here
as you enter them.

AutoSum button.

Format button.

Zoom button.
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Dolphin 9500/9550 HomeBase™
Overview

The Dolphin HomeBase charging and communication cradle supports both RS-232 and USB communications, which make it 
able to interface with the majority of PC-based enterprise systems. When a terminal is seated in the HomeBase, its main battery 
pack charges in less that four hours. In addition, the HomeBase contains an auxiliary battery well that charges a spare Li-ion 
battery. 

As the hub of your Dolphin 9500/9550 system, the Dolphin 9500/9550 HomeBase performs three important functions for your 
terminal – power, communications, and storage. 

Power 

The HomeBase provide power to the intelligent battery charging system incorporated into Dolphin terminals.

The charging/communication cradle also has an auxiliary battery well, located on the back of the cradle, allowing users to charge 
a spare battery.

Communications

Reliable data communications at speeds of up to 115k baud can be transmitted by the HomeBase through the RS-232 serial 
port. Using the full-speed USB port, the data transmission rate is12 Mbps. 

The HomeBase cannot be “daisy-chained” but can be networked together using a serial or USB hub.

Convenient Storage 

The Dolphin HomeBase provides a safe and convenient storage receptacle for your Dolphin terminal. 
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Dolphin 9500/9550 HomeBase Parts and Functions

Front Panel 

Terminal Well  

Place the Dolphin terminal in this well both to communicate with a host device. If the host device is a desktop computer 
that uses ActiveSync, synchronization begins immediately. While seated in the terminal well, the main battery installed 
in the terminal charges. The HomeBase completely charges a battery pack in less than four hours. 

Auxiliary Battery Well

See Rear Panel on page 12-4.

DOCK LED   

Turns solid green when the Dolphin terminal is properly seated in the Dolphin HomeBase. When this light is on, the 
terminal is connected and the battery in the terminal is charging.

AUX BATT LED 

Indicates status of the battery charging in the auxiliary battery well.   

This color means…

Orange the auxiliary battery is charging. 
Green the auxiliary battery has completed charging and is ready for use.

DOCK

AUX BATTERY

COMM

Terminal Well

DOCK LED

Auxiliary Battery Well

AUX Battery LED COMM LED
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COMM LED   

This is the communication LED. It indicates the status of data transfer between the Dolphin terminal and the host device 
the HomeBase is connected to. The color of this LED differs if the HomeBase is using the serial or USB port connection.

If using the serial port:    

If using the USB Port:

This color means…

Red Serial data is being sent from the Host Device to the Dolphin HomeBase. 
Green Serial data is being sent from the Dolphin HomeBase to the Host Device.
Orange Serial data is being sent at high data rates.

This color means…

Green LED A USB Connection is established with the host computer.
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Rear Panel 

Auxiliary Battery Well 

The HomeBase enables you to charge an additional Li-ion battery in this well. It operates independently of the terminal 
well and will charge the extra battery whether there is a terminal (with battery pack) seated in the terminal well or not. 
This feature ensures that you can always have a fully-charged battery for your Dolphin terminal. See Using the Auxiliary 
Battery Well on page 12-5.

USB Port

This USB Port is full-speed and 2.0 compliant. Using a USB cable, you can connect the HomeBase to a peripheral 
device such as a desktop computer or printer. When the Dolphin 9500/9550 is seated in the terminal well, it is connected 
to the peripheral device via the HomeBase.

The USB port on the HomeBase requires that you use ActiveSync 3.7 or higher.

RS-232 Port 

Use a 9-pin, RS-232 cable from HHP to connect this port to a peripheral device for RS-232 data communication. 

DC Power Jack 

Use a power cable from HHP to supply power to this power jack. For more information, see Powering the HomeBase 
on page 12-8.

Note: Please contact HHP for communication and power cable pricing and part numbers.

Auxiliary Battery Well

DC Power JackRS-232 PortUSB Port
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Using the Auxiliary Battery Well

The auxiliary battery well located on the back of the HomeBase allows users to charge a spare battery in less than four hours. 
Charging a Dolphin terminal and a spare battery pack can be done simultaneously because the auxiliary battery well operates  
independently of the terminal well. This means that the battery in the auxiliary well will charge whether or not the HomeBase is 
charging a main battery pack inside a terminal seated in the terminal well. 

The HomeBase senses when a battery pack is fully charged and automatically switches to maintain the battery at full capacity 
indefinitely.

To charge a spare battery in the auxiliary well, complete these steps:

1 Insert the end of the battery without the locking tab into the bottom of the auxiliary well opening.

2 Snap the battery into place with a hinging motion. 

3 Once the battery is inserted, you can use the AUX BATTERY LED to monitor the charging progress.
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Powering the Dolphin Terminal

The HomeBase charging/communication cradle powers the terminal while charging the battery installed in the terminal. It  
contains an intelligent battery charging system that protects the battery from being damaged by overcharging. Therefore, Dolphin 
terminals may be stored indefinitely in the charging/communication cradles without damage to the terminals, battery packs, or 
peripherals.

To charge a Dolphin terminal, complete these steps:

1 Insert a battery pack into the Dolphin terminal.

2 Place the terminal, imager window up and the LCD visible, in the terminal well of the cradle. 

3 Let it glide down into the well until it stops. 

4 When the Dolphin terminal is properly seated, the DOCK LED on the front of the cradle will be solid green.
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Setting up communications

Set the Dolphin HomeBase on a dry, stable surface, such as a desktop or workbench near an electrical outlet. Be sure to provide 
enough workspace with good lighting for the user to view and operate the Dolphin terminal while it is in the HomeBase.

Communications types

RS-232

The HomeBase supports RS-232 communications through the RS-232 Communications Port located on the back of the 
device.The HomeBase interfaces the RS-232 signals from the host computer to the RS-232 signals of the Dolphin 9500/9550 
mobile computer. 

The HomeBase’s RS-232 interface allows the Dolphin terminal to communicate to a personal computer, modem, or any RS-232 
device using a standard serial cable and communications software.

USB

The HomeBase also supports USB communications through the USB port located on the back. The HomeBase acts as a USB 
device by interfacing the USB signals of the Dolphin 9500/9550 to the USB of the host computer. Using a standard USB cable, 
the HomeBase’s USB interface allows the Dolphin terminal to communicate with a personal computer or to be networked through 
a USB hub.

Note: The HomeBase should have only one type of interface cable connected at a time, either USB or RS-232. You must be 
using ActiveSync, version 3.7 or higher.

Equipment requirements
To install and use the HomeBase, you need the following equipment:

• HomeBase connected to the appropriate power supply
• For RS-232 communications, a Serial cable 
• For USB communications, a USB cable 

CAUTION! Use only the power and communication cable from HHP. 
Dolphin® 9500/9550 Mobile Computer User’s Guide 12 - 7



Installing the HomeBase for RS-232 communications

Connecting the Cables
Connect the HomeBase to the host computer or other device by plugging an RS-232 serial cable into the RS-232 
Communications Port on the rear of the HomeBase. The wiring of your cable depends on whether the other device is set up as 
a Data Communications Equipment (DCE) or Data Terminal Equipment (DTE) device. 

The HomeBase Communication Port is configured as a DCE device. To communicate with a DCE device, use either a null 
modem adapter in line with a standard RS-232 cable, or a null-modem serial cable. To communicate with a DTE device such as 
a computer, use a standard (or straight-through) RS-232 cable.  

You can make your own cables by following the pin configuration in the chart below. To do so, you must determine if your host 
RS-232 device is 9-pin or 25-pin, and whether it is configured as a DCE or DTE device.

Note: The HomeBase cannot be daisy-chained.

Powering the HomeBase
The terminal requires 9.5 Volts DC input for communications and battery charging; the HHP power cable converts the power 
source voltage accordingly.

CAUTION! You must use the HHP power cable to power the HomeBase. Using another supply will damage the terminal.

1 Connect the HHP power cable to the DC jack on the rear of the HomeBase. 

2 Connect the HHP power cable to the power source.

HHP recommends that you leave the Dolphin HomeBase connected to its power source at all times, so that it is always ready to 
use.

HomeBase /Host Port 
(DCE)

IBM AT DB9 
(DTE)

IBM XT 
DB25 (DTE)

Modem DB25 
(DCE)

Pin /  Input Signal

2   /  (RD) 2 3 2

3   /  (TD) 3 2 3

5   /  (SG) 5 7 7

4   /  (DTR) 4 20 6

6   /  (DSR) 6 6 20

7   /  (RTS) 7 4 5

8   /   (CTS) 8 5 4
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HomeBase Serial Connector
The following diagram displays the serial connector of the HomeBase.  

The Home Base is at a right-angle to the printed circuit board (PCB). The ninth pin has a ring indicator (RI).

Configuring for RS-232 communication

Setting up the terminal

The Dolphin terminal may be configured for communications using the ActiveSync options as described in Chapter 2 or manually 
as described below.

To set Communications Properties, complete these steps:

1 Select Start > ActiveSync > Tools > Options. 

2 Select the PC tab.

Note:  Signals Referenced for a DTE Device

Pin #        Description

 1              Internal Jumper to Pin 6   
 2              TXD        
 3              RXD
 4              DSR
 5              GND
 6              DTR        
 7              CTS
 8              RTS        
 9              RI        
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3 Check the Enable synchronization box and select the desired option from the pull-down list; 115200 Default is 
recommended for an RS-232 connection. 

4 Click OK.

5 Place the Dolphin in the cradle. The Dolphin 9500/9550 attempts to start an ActiveSync connection with the desktop 
computer automatically.

Setting up the Desktop Computer

ActiveSync must be installed and configured for RS-232 on the desktop computer to sync successfully with a Dolphin 9500/9550 
device that is configured for RS-232 communication. 
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The following graphic displays the correct ActiveSync Connection Settings on the desktop computer for an RS-232 connection.

Note: You can have the USB connection box checked in addition to the serial cable box without affecting processing. However, 
you would most likely use one or the other.
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Installing the HomeBase for USB communication

The Dolphin 9500/9550 is defaulted to support USB communications out of the box.

Required equipment:

• HomeBase with power supply
• USB Cable
• ActiveSync v3.7 or above
• Windows® 98 second edition*, Windows® Me, Windows® 2000, or Windows® XP computer. 
Note: The HomeBase does not support Windows NT® when using a USB connection. This is because Windows NT does not 

support USB. 

*Windows® 98 second edition provides full USB support.

To install the HomeBase using USB

You must be using ActiveSync 3.7 or higher.

Complete these steps:

1 Plug in the power supply and connect it to the back of the HomeBase. 

2 Plug the USB cable into the back of the HomeBase.

At this point, the hardware is installed and operating. You may need to reset your PC to complete the installation process. You 
may also need to remove and then re-insert the Dolphin 9500/9550 in the HomeBase to initiate a USB connection. You can verify 
that the USB driver is functioning by watching the COMM LED on the USB home base. It should be solid green. 

Setting up the Terminal 

To select ActiveSync options:

1 Select Start > ActiveSync > Tools >Options. 

2 Select the PC tab.

3 Check the Enable synchronization box and select ‘USB Connection from the drop-down list. 

4 Click OK.
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5 Place the Dolphin in the cradle. The Dolphin 9500/9550 attempts to start an ActiveSync connection with the desktop 
computer automatically.

Setting up the Desktop Computer

After the USB HomeBase is installed, you can use ActiveSync to connect to a Dolphin 9500/9550. These instructions assume 
that ActiveSync v3.7 is installed on your PC. The latest version of ActiveSync can be downloaded from www.microsoft.com.

The ActiveSync Connection Settings must be set as the following graphic indicates.

The Allow USB connection with this desktop computer box must be checked. Do not check the serial cable box.
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Communicating with the Dolphin 9500/9550 Terminal

To initiate communications between the Dolphin 9500/9550 and its peripheral, complete these steps:

1 Insert the Dolphin into the terminal well of the HomeBase. The DOCK LED on the cradle illuminates.
If the Dolphin is in sleep mode, it will awaken into active state.  

If the Dolphin does not turn on, or the LED does not light up, make sure that it is properly seated in the terminal well and 
that the power supply is properly connected to the cradle and plugged into a functioning AC outlet.

2 The Dolphin 9500/9550 terminal automatically opens ActiveSync to establish a connection. Data can then be transferred 
between the terminal and the peripheral it is connected to via the Home Base.

If communication does not occur, check the port connections to ensure that the cradle is correctly configured. 

COMM LED

When data transfer begins, the COMM LED on the cradle blinks red and green for an RS-232 connection or solid green for a 
USB connection. 
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Mounting the HomeBase

For convenience and storage, the HomeBase can be mounted on a flat, horizontal surface such as a desk or workbench or a flat, 
vertical surface such as a wall. 

When choosing a location, always bear in mind that 

• the mounting location must allow users easy access to the Auxiliary Battery Well, and
• the serial and USB ports as well as the power jack face straight out of the rear panel and you will most likely want easy access 

to them in the future.

Desk Mounting

Dolphin charging/communication cradles have a DIN rail (7.5 X 35 mm) slot on the bottom to allow for secure desk attachment 
of the unit if desired.   

To mount the HomeBase, you slide the DIN rail slot along the bottom panel and secure it. Then, using the appropriate nuts and 
bolts, secure the DIN rail to the desk or flat surface. 

Auxiliary Battery Well
Serial and USB port location (not in view) 

DIN rail (7.5 X 35 mm) 
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Wall Mounting

The following diagram displays how to wall-mount a Homebase.

Note: The back wedge of the Mounting Bracket contains an open slot for the power and communications cables. It is also 
designed with extra space between the slot and the back panel of the HomeBase to allow easy access to the power and 
communications ports. For more details on both ports, see Rear Panel on page 12-4.

Secure screws to  
the bottom panel 
by sliding them 
into the available 
slots

Fasten the screws 
to secure the  
HomeBase to the 
Mounting Bracket

Turn the secured 
HomeBase right 
side up.

Attach the bottom 
panel to the 
Mounting bracket 
- match the holes 
to the secured 
screws

Using the 
appropriate 
screws as shown, 
secure the 
Mounting Bracket 
to the wall or 
vertical surface.
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Dolphin QuadCharger
Overview

The Dolphin® QuadCharger provides intelligent battery management for the Lithium Ion (Li-Ion) Dolphin 9500/9550 battery 
packs. It is a four-slot charging station for Dolphin Li-ion battery packs. It can charge each battery in less than four hours. The 
fourth slot features a battery analyzer that completely resets and re-calibrates a battery and displays its resulting capacity.

Capacity

This device contains four individual slots that each hold and charge one battery. It can fully charge up to four Li-Ion batteries in 
less than four hours. Charging slots work independently to control the charging of individual battery packs. 

Compatibility

The QuadCharger is compatible with the batteries for all models in the Dolphin 9500/9550 family of mobile computing devices.

CAUTION! Do not attempt to recharge any battery pack in the Dolphin 9500/9550 QuadCharger that is not manufactured by 
HHP specifically for this device. To do so will void your warranty and could damage the Dolphin 9500/9550 
QuadCharger. 

Charging process

As battery packs charge, the charging circuitry follows the two-step charging process (CC-CV) that is recommended for Li-Ion 
batteries. The process monitors changes in temperature, current, and voltage. The charger also resets and calibrates battery 
pack data to accurately show battery status on the Dolphin display.
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Dolphin QuadCharger Parts and Functions

Front View 

Charging Slots

The QuadCharger contains four charging slots. Each holds one Dolphin 9500/9550 battery. When a battery is placed 
in each slot it immediately begins charging.   

Charge/Analyze Slot

This is the fourth slot and the only one that can be used to charge or analyze a battery. When a battery is placed in this 
slot, it begins charging just as it does in the other three slots. However, if you press the Analyze button, it runs the battery 
in the slot through the complete Analyze cycle. For more information, see Using the Battery Analyzer on page 13-6.

Battery Capacity Indicator LEDS

Indicates the progress of the Analyze cycle of the battery in the Charge/Analyze slot.

Analyze Button

Press this button to start a battery analyze cycle. For more information, see Using the Battery Analyzer on page 13-6.

Status LEDs

A Status LED is located above each of the four battery slots. The color of the LED indicates the charge status of the 
batteries in its slot. 

Status LED color This color indicates that the battery in the slot…

Green Has completed its charge cycle and is ready for use

Orange Is being charged at a maximum charge rate

Red Encountered and error during the most recent charge cycle
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Rear View

Battery Analyzer

This is Charge/Analyze slot from the rear view.

Power Switch

Press the toggle switch to turn the QuadCharger on and off. 

Power Supply Connector

Use this connector to attach the power supply to the QuadCharger. The universal power supply accepts input voltages 
between 90-265 volts.

Supplying power to the QuadCharger
The charger must be connected to a power source for any type of operation. 

CAUTION!  Using a non-HHP power cord voids your warranty and could result in serious damage to the Dolphin 
QuadCharger’s circuitry.

Complete these steps:

1 Locate the AC power cord that came with the Dolphin QuadCharger. 

2 Plug the cord into the power supply connector on the back of the unit and then plug the power cord into a wall socket. 

3 Press the power switch. 
The Green power LED illuminates and the charger performs a self-diagnostic test that lasts approximately five seconds.

Inserting and removing battery packs 

Inserting

To insert a battery pack, place the end of the battery without the locking tab into the bottom of the charging pocket and snap the 
battery into place with a hinging motion. The Status LED for that particular slot illuminates orange when the battery has been 
properly inserted.

Removing

To remove a battery pack, push the locking tab down and pull the battery out from the charging slot with a hinging motion.

Storing Batteries

Recommendations

To maintain top performance from batteries, follow these storage guidelines:
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• Avoid storing batteries outside of the specified temperature range of -4 to 104° F (-20 to 40°C) or in extremely high humidity.
• For prolonged storage, do not keep batteries stored in a charger that is connected to a power source. 
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Charging batteries in the QuadCharger

CAUTION! Do not attempt to recharge any battery pack in the Dolphin 9500/9550 QuadCharger that is not manufactured by 
HHP specifically for this device. To do so will void your warranty and could damage the Dolphin 9500/9550 
QuadCharger. 

Recommendation

For best results, battery packs should be at room temperature before recharging them; temperature has a marked effect on 
charging. The recommended temperature range is 50° to 95° F (10° to 35° C). 

Complete these steps:

1 Set up the QuadCharger.

2 Supply the QuadCharger with power and turn the power switch on.

3 Insert batteries into the appropriate slots. The Status LED for each slot turns orange to indicate that the battery has begun a 
charge cycle.

4 When the Status LED turns green, the battery in the slot has completed charging.
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Using the Battery Analyzer 

Location

The fourth slot of the QuadCharger is known as the Charge/Analyze slot because it contains a battery analyzer. When a battery 
is placed in this slot and the Analyze button is pressed, it runs the battery through the Analyze cycle.

Note: The fourth slot is the only one that contains an analyzer. 

Analyze cycle

The Analyze cycle is initiated when a battery is placed in the Charge/Analyze slot and the Analyze button is pressed. At that time, 
only the battery in the Charge/Analyze slot is analyzed. 

In an Analyze cycle, batteries are completely discharged and then recharged to capacity. The indicator LEDs display just what 
that capacity is at the end of the cycle. The battery is completely reset and re-calibrated. Resetting and calibrating batteries on 
a regular basis can provide longer and more consistent performance from those batteries. 

The length of time it takes for a battery to run through the complete Analyze cycle varies depends on initial state of the battery. 
Minimum time is 8 hours, maximum time is 12 hours.

Battery Capacity Indicator LEDs

The Battery Capacity Indicator LEDs are located along the right side of the Charge/Analyze slot. These LEDs illuminate after the 
completion of the Analyze cycle. Upon the completion of the final charge, these LEDs display the measured capacity of the 
battery. Battery capacity is displayed as a percentage of measured capacity/rated capacity. Each LED equates to 10% battery 
capacity.   

Status LED

The Charge/Analyze slot also contains a Status LED in the upper, left corner of the slot. When this slot is used for regular 
charging, this LED operates in the usual manner; see Status LEDs on page 13-2.

When this slot is being used to analyze a battery, the Status LED functions as the following table describes:

To analyze a battery
Complete these steps:

1 Insert the battery into the Charge/Analyze slot (the fourth).

2 Press the Analyze button. The Status LED flashes orange to indicate that the analyzing cycle has begun.

3 Upon completion, the Status LED is solid green and the Battery Capacity Indicator LEDs display the current battery capacity.

CAUTION! Because the Dolphin QuadCharger is accumulating battery pack information during the entire Analyze cycle, it is 
important not to remove the battery until the cycle has been completed. 

Status LED color This color indicates that the battery in the slot…

Solid Green Has completed the Analyze cycle. 

Flashing Orange Is being analyzed. 

Solid Red Encountered an error during the Analyze cycle.
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